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The resulting file should have a lavendar-colored header, and a panel on the left side of the screen 
should have opened. This is the Form Field Recognition report.

The section of the report entitled Detected Form Fields is the list of fields that the tool has deter-
mined exist on your form. To see the fields that the tool has added, click on the Highlight Fields button 
at the top right of your PDF file. This will highlight the form fields in blue.

However, before we get too excited about how easy that was, scroll through the Detected Form Fields 
list. At the end of each bulleted item, there will be an identifier in square brackets. Note that each of 
these is [Text Field]. What the forms recognition tool did was insert a text field form field in each space it 
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determined to be a form item. It also inserted fields where we don’t want or need them, and it may have 
missed areas where we need a field. Obviously, there’s allot of clean-up that will need to take place on 
this form before it is ready for distribution.

However, note that this method of creating a form in the Windows ver-
sion of Acrobat actually saves the form structure as LiveCycle Designer 
structure. This means the form will no longer be editable in any version 
of Acrobat, and can only be edited thereafter in LiveCycle.

LiveCycle Designer is a very flexible and powerful forms creator, and 
offers much more control over the behavior of the form and the fields. 
However, for the purposes of this course, we will not be covering those topics, and will be concentrat-
ing on understanding Acrobat’s forms creation capabilities. If you work in Windows, and have mastered 
Acrobat’s forms tools, you can always open your forms in LiveCycle Designer and learn those advanced 
tools. Just remember that if you save a form in LiveCycle Design, you will not be able to edit the form in 
Acrobat any longer.

Manual Form Fields Creation (Windows)

To create form fields by hand, open your form template PDF file, and then click on View  Toolbars  
Forms

Manual Form Fields Creation (Macintosh)

To create form fields by hand, open your form template PDF file, and then click on Forms  Add or 
Edit Fields...

Note  LiveCycle Designer is 
not available for Macintosh. So 
if you need to keep your form 
editable in both environments, 
make sure you only use 
Acrobat’s forms tools.
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Since no form fields currently exits in this file, an alert dialog will ask us if we wish to have the applica-
tion automatically detect form fields. Click No.

Acrobat will enter its edit form fields view as shown below. The Add New Field button on the left con-
tains all the available form fields. The Preview button will enter a preview mode. The Distribute Form 
button on the right will send the form through email using a distribution list you provide. When we’re 
done editing the form, we’ll click the Close Form Editing button to make the form active. (see the fol-
lowing page)
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To make adding the form fields easier, we’ll click on Add New Field  Show Tools on Toolbar.

This will add all the available form fields onto the top of our application window.
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After collapsing the form field list in the left panel, our Windows and Macintosh form views look pretty 
similar. I’ll collapse the formatting and navigation toolbars in the Windows version just to make the 
application windows look even similar.

Task 4:  Populating the Form Fields

To add a form field, simply click on the type of field needed, and click 
into the position you need it to be. In the example below, I have added a 
Text Field below the form title. This field will be used to specify for what 
company the form filler is applying for employment.

Note  Acrobat version 9 added 
a Keep Tool Selected button 
in the Forms toolbar. Clicking 
this will the current form tool 
active. Otherwise, you must 
return to the toolbar to re-select 
the desired form field every 
time you wish to place one into 
the layout.
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To re-size the form field, select the arrow tool from the toolbar, and stretch the form field as needed. 
Now we’ll need to specify our field’s parameters. Do so by double-clicking the field, which launches the 
Form Field Properties dialog box. The properties we’ll concern ourselves with in the General tab are 
the Name and Tooltip values. For purposes of this form, the name can be any unique identifier. Here, I 
have called it CompanyName. The Tooltip will be the text that get displayed when the form user holds 
their mouse over the form field. Though not necessary, fully tipped fields are usually good idea when 
planning for the common denominator.

The Appearance tab determines the visual attributes of our field. Since this form is already populated 
with borders on all the fields, we’ll not be needing to add them here. I have selected 10 point for the size 
of the type, but you select either one of the pre-populated sizes from the list, or enter a value of your 
own. Also, Acrobat has an Auto value that will size text as large or as small as it needs to be in order to 
fill the available space, or fit all the text. I have also selected blue text, although you can select from any 
value within Acrobat’s palette.
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The Options tab while control how content behaves within the text field. This case, I want only a single 
line of text, and no local formatting, so I have disabled all the options, but made sure that the text will 
be centered on the line so that aligns with the form title above.

For this field’s purposes, none of the other tabs — apply, so I’ll ignore those here. Closing the Field 
Properties dialog, my form now looks like this...
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Since I have created one Text Field, and I know I have many more, and 
that they’ll probably share many of the same formatting and behavior 
attributes, I’ll just the field I just created and paste as I need it for the 
first two lines of content (which are all Text Fields). In these fields, I 
changed the text alignment on the Appearance tab to Left.

Note  when copying and 
pasting fields, you must make 
sure to change their Name 
value. Otherwise, the fields will  
duplicate each other’s value...
and that is seldom desired 
(though sometimes that has its 
purposes).
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The Social Security Number, Zip Code, and Phone Number fields have specific formatting constructs 
to ensure their data is input consistently and according to possible database needs. In the case of the 
Social Security Number, I have clicked on the Format tab in the Field Properties dialog, selected 
Special from the Select format category: list, and applied the Social Security Number format.

Now we’ll add a couple of radio buttons in the citizenship and full time/part time fields. The key trick 
here is to ensure that all radio buttons that are to be mutually exclusive have the same field Name, but 
that each of the buttons have a different Button Value. Therefore, the evidence of legal eligibility fields 
I have named both LegalEligibility. The Yes button has a value of Yes, and the No button a value of No.

 

In the position desired field, it is likely that you’ll want to restrict the 
application to selecting a single position, so in this space we’ll place a 
Combo Box.

Note  the difference between 
List Box and a Combo Box form 
fields is that the user may make 
multiple selections of the items 
presented in the list, while a 
Combo Box restricts the user to 
making a single choice.
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Within the field Properties dialog, you will populate the items con-
tained within the list on the Options tab by entering the information in 
the Item value, then clicking on the Add button. If a value other than 
what you entered in the Item value is required when the form results 
are exported, you can enter the value for the list item in the Export Value field. Otherwise the item 
name will be used upon export. The Sort Items check box will force the list items into alphabetical (or 
numeric) order. The Allow user to enter custom text will permit the user to type in their own value to 
the form field.

The Wage/Salary Desired field is handled as a Text Field, but it must contain a number in terms of USD 
currency. So, we need to handle its formatting as we did for the Social Security Number.

Note  which list item is selected 
in the field Properties dialog will 
be the default item in the form.
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We will continue along in this manner continuing to populate the form with the appropriate fields. 
However, at this point I would like to discuss what the user does with the form data once it is completed. 
So now we will add a button which will email the form to a user, a button to print the form, and in the 
case where a user must start all over from scratch, a button to clear the form.

To begin, we’ll select the Button tool, and place a button at the top-right, and one at the top-left cor-
ners of the document.

The top-left button will be for the email function, so we’ll double-click on that to open the Form Field 
Properties dialog. I’ve given this button the name emailForm. On the Options tab, I have entred the 
value e-mail Form in the Label field. This is the text that will on the button itself. You can also specify 
a graphic here if you would like. The Layout list item specifies what kind of content you would like to 
include on the button’s face. Our button will only include the label.
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On the Actions tab, I have selected the Mouse Up trigger and Submit 
a Form from the Selection Action menu item. The Mouse Up trigger 
means that when a user clicks on the button, the action indicated will 
execute when the mouse is released.

For our form, we want the form data submitted to an email address, so now we’ll click on the Add... 
button, which calls up the Submit Form Selections dialog box. The Enter a URL for this link: field is 
intended for a website link where you might send data as a text file where it is retrieved by a database. 
However, since we want the form data emailed to us, we’re going to enter a mailto: command.

In the case of our form, we’re sending the data results as an FDF (forms data format) file. Once the email 
recipient receives the FDF file, they can import the file into their own copy of the PDF form, or parse the 
information as a text-only file into a database. And since we’re only interested in the form results, I have 
told the export not to include any comments or, changes in the PDF. Also, while the results as an HTML 

Note  the Select Action menu 
contains a number of building 
blocks you can assign to the 
button to make programming 
the button very simple. If you 
are skilled in programming 
Visual Basic, C# or similar 
language, you can also program 
these buttons with a number of 
other executable actions.
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page would be small to email, a database may not be able to parse the information. And XFDF is a spe-
cialized format that includes structure much like an XML file. And including the entire PDF file would be 
unnecessarily large for emailing. So, sending the FDF files makes the most sense for this use.

The Print button we’ll handle in a similar fashion, except on the Actions tab of the Form Field 
Properties dialog, we’ll select the Execute a menu Item option on Mouse Up.

The Print button we’ll handle in a similar fashion, except on the Actions tab of the Form Field 
Properties dialog, we’ll select the Reset a Form option on Mouse Up. This button I’ll place at the bot-
tom of the page in the left corner.


